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Experiment HE-2: Recovery from 
Exercise

Background

During exercise, there is an increased demand for 

oxygen in muscles and an increased need to move 

carbon dioxide away from those muscles. People with 

higher levels of physical fitness usually have higher 

stroke volumes and can deliver more oxygen in a single 

cardiac cycle than people with lower levels of fitness. 

More fit persons can usually sustain a greater work level 

before reaching maximum heart rate. Less fit subjects of 

the same age and gender will reach about the same 

maximum heart rate, in a shorter period of time; and, 

they are usually unable to sustain the same level of 

work. However, the time from resting to maximum heart 

rate is not a good indicator of fitness; this time is a 

reflection of the effort put into exercise by the subject.

As soon as exercise stops and the demand for oxygen 

and the transport of carbon dioxide decreases, heart 

rate decreases. The heart rate of a more fit person 

usually returns to the resting rate more quickly than it 

does in a less fit subject. Recovery rate, which is the 

drop in heart rate between the end of exercise and the 1-

minute mark of the recovery period, is an excellent 

measure of fitness. Studies have shown that a drop of 50 

beats in the first minute indicates excellent fitness, and a 

drop of less than 30 beats in the first minute indicates 

poor fitness. The time to recover to the resting level is 

also a good indicator of fitness, though less used than 

recovery rate. More fit subjects take shorter times to 

reach complete recovery.

Cardiorespiratory fitness levels can be determined 

through many types of aerobic assessment: the 2-

minute, positional step test; the 3-minute step test; the 

1-mile walk test; and more. In this experiment, the heart 

rates of human subjects will be measured as they 

recover from a three minute period of stepping. The 

heart rate at a minute into recovery, and the time it takes 

the subject’s heart rate to return to the resting level, will 

be used as measures of the subject’s level of the 

physical fitness.

Equipment Required

PC Computer

IWX/214 data acquisition unit

USB cable

IWX/214 power supply

PT-104 Pulse plethysmograph

Step (30cm (12in) in height)

Metronome (electronic or mechanical)

Stopwatch

IWX/214 Setup

1 Place the IWX/214 on the bench, close to the computer.

2 Check Figure T-1-1 in the Tutorial Chapter for the location of 

the USB port and the power socket on the IWX/214.

3 Check Figure T1-2 in Tutorial Chapter for a picture of the 

IWX/214 power supply.

4 Use the USB cable to connect the computer to the USB port 

on the rear panel of the IWX/214. 

5 Plug the power supply for the IWX/214 into the electrical 

outlet. Insert the plug on the end of the power supply cable 

into the labeled socket on the rear of the IWX/214. Use the 

power switch to turn on the unit. Confirm that the red power 

light is on.

Start the Software

1 Click on the LabScribe shortcut on the computer’s desktop 

to open the program. If a shortcut is not available, click on 

the Windows Start menu, move the cursor to All Programs 

and then to the listing for iWorx. Select LabScribe from the 

iWorx submenu. The LabScribe Main window will appear 

as the program opens.

2 On the Main window, pull down the Settings menu and 

select Load Group.

3 Locate the folder that contains the settings group, 

IPLMv4.iwxgrp. Select this group and click Open.

4 Pull down the Settings menu again. Select the Recovery-

Exercise-LS2 settings file.

5 After a short time, LabScribe will appear on the computer 

screen as configured by the Recovery-Exercise-LS2 

settings.

6 For your information, the settings used to configure the 

LabScribe software and the IWX/214 unit for this exper-

iment are listed in Table HE-2-1 on page HE-2-1. These 

settings are programmed on the Preferences Dialog 

window which can be viewed by selecting Preferences 

from the Edit menu on the LabScribe Main window.

Table HE-2-1: Sett ings on the Channel Window 

of the Preferences Dialog Used to Configure the 

iWorx Recording System for Experiment HE-2.

Parameter Uni ts/Ti t le Sett ing
Mode/

Function

Acquis i t ion Mode Chart

Star t User

Stop User

Display Time Sec 10

Speed Samples/Sec 200

Channel  A3 Pulse S DIN8

Channel  C1 Heart  Rate S P.Rate
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Pulse Sensor Setup

1 Locate the PT-104 pulse plethysmograph (Figure HE-2-1 on 

page HE-2-2) in the iWorx kit.

2 Plug the DIN8 connector to the PT-104 into the Channel 3 

input of the IWX/214 data recording unit (Figure HE-2-2 on 

page HE-2-2).

 Figure HE-2-1: The PT-104 pulse plethysmograph.

 Figure HE-2-2: The PT-104 pulse plethysmograph connected to an IWX/214.

3 Place the plethysmograph on the volar surface (where the 

fingerprints are located) of the distal segment of the 

subject’s middle finger, and wrap the Velcro strap around 

the end of the finger to attach the unit firmly in place.

Preparation before Exercise Begins

1 Each subject will perform a 3-minute period of stepping. 

There will be a 5-minute rest period before the 3-minute 

exercise period, and a recovery period after stepping that 

will be as long as it takes the subject’s heart rate to return to 

the resting value. Lab partners should keep time for the rest, 

exercise, and recovery periods.

Warning: The Step Test should not be attempted by 

individuals with a very poor level of physical fitness, or 

individuals taking a beta blocker medication or any 

medication affecting heart rate.

2 The step rate will be 24 steps per minute. 

3 Each step is a four-beat cadence, so the metronome will be 

set to 96 beats per minute.

4 The movements for each of the four beats in a step are:

• 1st beat: Right foot up on step.

• 2nd beat: Use the right leg to lift body, and place left foot on 
step

• 3rd beat: Lower the right foot to the ground.

• 4th beat: Lower the left foot to the ground.

5 It is important to secure the step against the side of a lab 

bench or up against a wall to prevent it from slipping from 

under the feet of the subject.

Exercise 1: Heart Rate at Rest

Aim: To measure the heart rate of a resting subject.

Procedure

1 Instruct the subject to sit quietly and rest with his or her 

hands in the lap for five minutes.

2 Type <Subject’s Name> Sitting at Rest in the Mark box 

that is to the right of the Mark button.

3 At the end of the five minute rest period, click on the 

Record button, located on the upper right side of the 

LabScribe Main window. The signal should begin scrolling 

across the screen.

Note: If the user clicks the Record button and there is no 

communication between the iWorx unit and computer, an error 

window will appear in the center of the Main window. Make 

sure the iWorx unit is turned on and connected to the USB port 

of the computer. Click OK and select the Find Hardware 

function from the LabScribe Tools menu. 

4 Click on the AutoScale buttons at the upper margins of the 

Pulse and Heart Rate channels. The pulse signals and 

heart rate histogram should expand to fill the channel 

windows (Figure HE-2-3 on page HE-2-3). 

• If the signal on the Pulse channel is upside down when 
compared to trace in figure, click on the downward arrow to the 
left of the channel title and select the Invert function. the trace 
should now look similar to the one in the figure.

• If the pulse signal is small or noisy, adjust the tension on the 
strap holding the pulse plethysmograph to the finger.

5 Record the subject’s resting heart rate for one minute. Then, 

click Stop to halt the recording.
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6 Select Save As in the File menu, type a name for the file. 

Choose a destination on the computer in which to save the 

file, like your lab group folder). Designate the file type as 

*.iwxdata. Click on the Save button to save the data file

7 Remove the pulse plethysmograph from the subject’s finger.

 Figure HE-2-3: Pulse and heart rate from a resting subject displayed in the 

Main window.

Data Analysis

1 Scroll to the beginning of the recording of the subject’s heart 

rate while at rest. Display a ten second section of data that 

is free of artifacts in the Main window.

2 Use the Display Time icons to adjust the Display Time of 

the Main window to show ten seconds of data on the Main 

window. The ten second section of data can also be 

selected by:

• Placing the cursors on either side of the ten seconds of data; 
and

• Clicking the Zoom between Cursors button on the 
LabScribe toolbar (Figure HE-2-4 on page HE-2-3) to expand 
the ten seconds of data to the width of the Main window.

 Figure HE-2-4: The LabScribe toolbar.

3 Click on the Analysis window icon in the toolbar (Figure 

HE-2-4 on page HE-2-3) or select Analysis from the 

Windows menu to transfer the data displayed in the Main 

window to the Analysis window (Figure HE-2-5 on page 

HE-2-3).

4 Look at the Function Table that is above the uppermost 

channel displayed in the Analysis window. The mathe-

matical function, Mean, should appear in this table. The 

value for the mean heart rate should appear across the top 

margin of the Heart Rate channel.

5 Place a cursor near the beginning of the data displayed on 

the Analysis window, and place the other cursor near the 

end of the data displayed on the window. The cursors are in 

the correct positions for determining the mean resting heart 

rate of the subject from the ten seconds of data on the 

window.

6 Record the mean resting heart rate of the subject in the on-

line notebook of LabScribe by typing the name and value of 

the parameter directly into the Journal. You can open and 

close the Journal by clicking on its icon on the LabScribe 

toolbar (Figure HE-2-4 on page HE-2-3).

 Figure HE-2-5: Pulse and heart rate from a resting subject displayed in the 

Analysis window.

7 The functions in the channel pull-down menus of the 

Analysis window can also be used to enter the names and 

values of parameters from the recording to the Journal. To 

use these functions:

• Transfer the names of the mathematical functions used to 
determine the volumes and rates to the Journal using the Add 
Title to Journal function in the Heart Rate Channel pull-
down menu.

• Transfer the values for the volumes and rates to the Journal 
using the Add All Data to Journal function in the Heart Rate 
Channel pull-down menu.

8 Record the mean resting heart rate for in Table HE-2-4 on 

page HE-2-5.

Exercise 2: Heart Rate During Recovery

Aim: To measure the changes in the heart rate of the 

subject while he or she recovers from exercise.

Procedure

1 After the subject’s resting heart rate is recorded, the subject 

should stand in front of the step and await the signal of the 

timekeeper.

2 Once the timekeeper calls “Start!”, the subject should begin 

stepping at the rate of 24 steps/minute for 3 minutes.

3 While the subjects are stepping, the lab partners can enter 

pertinent data into the Journal. 
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4 30 seconds before the end of the stepping exercise, the 

timekeeper should alert the subject and other lab partners 

to be ready attach the pulse plethysmograph. Type 

Recovery from Exercise in the Mark box that is to the 

right of the Mark button.

5 The timekeeper should give the subjects and the lab 

partners a 10 second countdown before calling “Stop!”. At 

the end of the 3-minute stepping exercise, each subject 

should immediately sit in a chair and attach the pulse 

plethysmograph to the same finger with about the same 

tension used earlier.

6 As soon as the subject is seated and the pulse plethysmo-

graph is in place, click on the Record button. Click on the 

AutoScale buttons on both channels.

7 Continue to record the subject’s pulse until his or her heart 

rate returns to the resting level. Click on the Stop button.

8 Select Save in the File menu.

Data Analysis

1 Scroll to the beginning of the recording of the subject’s heart 

rate during the recovery period. Display a ten second 

section of data that is free of artifacts in the Main window.

2 Use the Display Time icons to adjust the Display Time of 

the Main window to show ten seconds of data on the Main 

window. The ten second section of data can also be 

selected by:

• Placing the cursors on either side of the ten seconds of data; 
and

• Clicking the Zoom between Cursors button on the 
LabScribe toolbar (Figure HE-2-4 on page HE-2-3) to expand 
the ten seconds of data to the width of the Main window.

3 Click on the Analysis window icon in the toolbar (Figure 

HE-2-4 on page HE-2-3) or select Analysis from the 

Windows menu to transfer the data displayed in the Main 

window to the Analysis window.

4 Position a cursor on either side of the five pulses on the 

Pulse channel. The value for Mean in the table across the 

upper margin of the Heart Rate channel is the subject’s 

mean heart rate at the start of the recovery period.

5 Record this value in the Journal using one of the two 

techniques described in Exercise 1. Enter the value for this 

mean heart rate in Table HE-2-4 on page HE-2-5.

6 Use the same techniques described earlier to measure the 

mean heart rate at one minute intervals from the beginning 

of the recovery period. Record these values in the Journal 

and on Table HE-2-4 on page HE-2-5.

Fitness Ratings

1 For each subject, use the measurements made in the Data 

Analysis section to fill in Table HE-2-4 on page HE-2-5.

2 From the data in Table HE-2-4 on page HE-2-5, determine:

• The difference between the subject’s resting and maximum 
heart rates.

• The difference between the subject’s maximum and 1-minute 
recovery heart rates.

• The time for the subject to recover from maximum heart rate 
to a heart rate equal to the resting rate.

3 Compare the subject’s 1-minute recovery heart rate to the 

first table of fitness ratings (Table HE-2-2 on page HE-2-4).

4 Compare the subject’s time to recover to his or her resting 

heart rate to the ratings in a second fitness table (Table HE-

2-3 on page HE-2-4).

5 Enter measurements and ratings into the Journal by typing 

them directly into the Journal window.

Table HE-2-2: Fitness Rating based on Heart 

Rate at 1-Minute into Recovery after a 3-Minute 

Aerobic Step Test.

Table HE-2-3: Fitness Rating based on the Time 

to Recover to Resting Heart Rate.

Questions

1 How does the difference between the resting and maximum 

heart rate of a subject relate to his or her fitness?

2 How do the resting and maximum heart rates of all the 

subjects compare? Do the subjects’ levels of fitness 

correlate to the resting heart rates, the maximum heart 

rates, and/or the differences between the two heart rates?

Fitness Rat ing Gender Heart  Rate (BPM)

Excel lent
Male <71

Female <97

Good
Male 71-102

Female 97-127

Fair
Male 103-117

Female 128-142

Poor
Male 118-147

Female 143-171

Very Poor
Male 148+

Female 172+

Time to Recover to 

Rest ing Heart  Rate
Rat ing

0-30 secs Excel lent

31-60 secs Good

61-90 secs Fair

91-120 secs Poor

121+ secs Very Poor
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3 How does the difference between the maximum and 

recovery heart rate of a subject relate to his or her fitness?

4 How do the maximum and recovery heart rates of all the 

subjects compare? Do the subjects’ levels of fitness 

correlate to the maximum heart rates, the recovery heart 

rates, and/or the differences between the two heart rates?

5 How does the time taken to recover to resting heart rate 

relate to the fitness of each subject? How do the times to 

recovery for all the subjects compare?

6 How do the two techniques of determining fitness (1-minute 

recovery and time to recovery) compare to each other? Are 

they consistent?

7 Do you agree with the fitness ratings obtained from this 

experiment? Explain.

8 Examine the data of a fit subject. Predict what his or her 

maximum heart rate might be, if he or she exercised for 5 

minutes instead of 3 minutes.

9 Examine the data from a less fit subject. Predict what his or 

her maximum heart rate might be, if he or she exercised for 

5 minutes instead of 3 minutes.

Table HE-2-4: Heart Rates at 1-Minute Intervals into Recovery

Rest Max

Time (mins) 0 1 2 3 4 5 6 7 8 9 10

HR

(BPM)
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